
Web applications design 
Semester B, Mandatory modules, ECTS Units: 3 

http://webdesign.georgepavlides.info 

http://georgepavlides.info/tools/html_code_tester.html  

 

 

George Pavlides 
http://georgepavlides.info 



course outline 
�  Introduction 

�  What is 'design' 
�  What is the Web 
�  What are the principles 

�  Client-side web programming 
�  Markup languages 
�  Static programming with HTML 
�  Dynamic programming with CSS and JavaScipt 
�  Introduction to HTML5 

�  Visual media production 
�  Introduction to light, vision, perception 
�  Introduction to basic image processing 
�  Grid design with image processing 
�  The golden ratio in design 

�  Server-side web programming 
�  Introduction to PHP and MySQL 
�  Usage of open-source CMS/blog packages 



Introduction to light, vision 
and visual perception 

on the way we see things… 



light 
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light 

!!Particle theory of light 
!! Newton (1675) 

!! light is a continuous stream of particles 
traveling in a straight line 

!!Wave theory of light 
!! Robert Hooke (1660) 
!! Christiaan Huygens (1678) 
!! Leonhard Euler (1746) 
!! Thomas Young (1800s) 
!! Augustin-Jean Fresnel (1817) 
!! Simeon Denis Poisson (1820s) 



light 
!!Electromagnetic theory of light 

!! Michael Faraday (1845) 
!! James Clerk Maxwell (1862, 1873) 
!! Heinrich Hertz 

!!Special relativity (duality in the nature of 
light) 
!! Einstein (1905) 

!! Solution to the paradox of the constant speed 
of light: space & time ! variable quantities 

!! Correlation of energy, mass and the speed of 
light E=mc2 

!! Solution to the photoelectric phenomenon 
paradox 

!!Quantum mechanics and electrodynamics 
!! Max Planck (1900s) 

!! Blackbody radiation ! packets or quanta ! 
photons E=hf=hc/! 



light 



light and the human vision 

!! Kepler (1604) 
!! theory of diffraction by spherical 
lenses 
!! application of theory to the eyes  
!! considered the first to recognize that 
images are projected onto the retina 
reversed 

!!The retina 
!! does not correspond to a film (a set 
of passive sensors) 

!! consists of a finite number of 
sensors 



the light sensing device 
Lens characteristics: 

•! Slightly yellowish color to 
compensate for chromatic aberration 

•! Absorbs about 10% of light 
•! Emits at 300-1600nm 

•! Is sensitive to infrared 
and ultra violet 

The retina and  
concentration of cones and rods 

compensate for chromatic aberration

Horizontal section 
of the left eye 



formation of an image 

An open philosophical issue: How is it possible to perceive 
that objects are different from us when their images are formed within us? 

An open philosophical issue
that objects are different from us when their images are formed within us? 

formation of an image 



visual acuity 
�  Estimation of eye’s resolution 

�  ACTUALLY CANNOT BE DEFINITELY ESTIMATED 
�  The eye is a video camera continuously moving the 
focus and center of the viewing field 

�  can distinguish two fine lines if they are 
separate by at least 0.6 arc-minutes (0.01 
degrees) 
�  equivalent pixel size of 0.3 arc-minutes 
�  for 120 degrees field of view è 576 Mpixels 

�  120o x 60arc-min/o x 1/0.3px/arc-min = 24.000 px for 1D 
�  Really detailed vision only within the central field of 
view (2o the fovea; and no more than 20o) 

�  corresponds to a resolution no more than ~7 Mpixels 
�  plus ~1 Mpixel for the rest of the field of view 

�  Color resolution 
�  256 shades of each of the primary colors 

�  è 2^24 = 16.7 million colors 
more here:  
http://webvision.med.utah.edu/book/part-viii-gabac-receptors/visual-acuity/ 
http://clarkvision.com/articles/eye-resolution.html  



http://xkcd.com/1080/large/  



visual acuity visual acuity 



the retina 
!! Cones 

!! Cone-shaped cells 
!! Three types 

!! S, M, L depending on 
the sensitivity 
!! 420, 530, 560 nm 

!! S cones ! 7%, L:M=1,5 
!! Fovea 

!! ~150.000 cones/mm2 
!! Day vision 

!! Rods 
!! Cylindrical cells 
!! Max sensitivity 

!! 550 nm 
!! Night vision 



the retina 
Rods Cones 

Night vision (males excel) Day vision (females excel) 

Very sensitive to light 
Not to sensitive to light 
Sensitive to direct light 

Loss è night vision blindness Loss è blindness 

Low visual acuity High visual acuity 

Not present in fovea Mostly concentrated within the fovea 

Low response to light 
Sensitivity enhances with time 

Fast response to light, perception of 
high contrast prevails 

Contain more amount of pigment and 
can thus detect low light levels 

Contain less amount of pigment and 
thus cannot detect low light levels 

20 times more than cones on the 
retina (~90 million) ~4.5 million 

One type of pigment Three types of pigment 

Graylevel (B&W) vision Color vision 



brightness sensitivity 

Middle gray– 18% 



contrast sensitivity 

Spatial frequency c/deg 



color sensitivity 

Day vision 

Night vision 



depth perception 

!! Coupling of the two different views 
from the eyes 
!! Wheatstone (1838) ! Stereoscope ! 
Viewmaster Viewmaster

1838) ! Stereoscope !



content perception 
!! Plato’s ‘allegory of the cave’, 7th chapter of ‘Politeia’ (380 bC) 

!! Socrates describes a gathering of people who have lived 
chained to the wall of a cave all of their lives, facing a 
blank wall. 

!! The people watch shadows projected on the wall by things passing in front of a 
fire behind them, and begin to designate names to these shadows. 

!! The shadows are as close as the prisoners get to viewing reality. 

!! Analogy of the human perception 
!! The perception of the world around us is made up of 
reflections of the external world within us 

!! Perception is a synthetic processing within the brain that 
is based on sensory data 

 within the brain that 

Raphael (1508-11): Plato and Aristotle 
talk in the Athenian Agora 



psycho-optics and vision limitations 

�  Visual perception and logic 
�  Experiment: Speak out the color of the 
words and not the words themselves. 

�  The right brain tries to speak the color 
whereas the left brain insists on reading 
the word 

 YELLOW    BLUE     ORANGE 
 BLACK     RED      GREEN 
 VIOLET    YELLOW   RED 
 ORANGE    GREEN    BLACK 
 BLUE      RED      VIOLET 
 GREEN     BLUE     ORANGE 



psycho-optics and vision limitations 

!! Motion illusion 



psycho-optics and vision limitations 

�  Color illusions 



psycho-optics and vision limitations 

�  False distortions and waves 



psycho-optics and vision limitations 

�  False distortions 



psycho-optics and vision limitations 

!! Color constancy 
!! Relative perception of same brightness or 
color under different lighting conditions 

!! Rectangles A and B have the same gray value – 
Similarly, the orange points are of the same brightness 

color under different lighting conditions 

! Rectangles A and B have the same gray value – 

color under different lighting conditions color under different lighting conditions 



color and color perception 
�  MeSH (medical subject heading, National Library of 

Medicine) 
�  Vision: The process in which light 
signals are transformed by the 
photoreceptor cells into electrical 
signals which can then be transmitted to 
the brain 

�  Visual perception: The selecting and 
organizing of visual stimuli based on the 
individual's past experience 

�  Color perception: Mental processing of 
chromatic signals from the eye by the 
visual cortex where they are converted 
into symbolic representations 

�  Color: The visually perceived property of 
objects created by absorption or 
reflection of specific wavelengths of 
light 



color and color perception 

!! …as far as we are concerned, all 
these correspond to human perception 



Introduction to basic image processing 

Working with Adobe Photoshop 

(covers CS5 edition) 



introduction to photoshop 

� Adobe Photoshop is an extended 
application software for image 
processing 

� Nearly everyone has (at least) heard 
of it  

� People working in imaging and 
multimedia are very accustomed to it 

� But only few are able to use it to its 
extreme capabilities 



introduction to photoshop 

� With Photoshop one can 
�  Process digital imaging (raster graphics) 

�  Apply color transformations 
�  Apply geometric transformations 
�  Apply processing on single video frames 
�  Apply processing of 3D graphics 

�  Design vector graphics 
�  Mix processing and design 

�  Produce highly complex compositions 



description of the environment 

Menu bar 

Toolbox 

Tool options bar 

Status bar 

Panels/Palettes 



description of the environment 

!!Menu bar 
!! Typical menu bar in horizontal alignment 
!! Includes all capabilities of processing  
!! Menu bar can be customized 

!!Tool options bar 
!! Horizontal bar under the menu bar 
!! Includes all options for available tool 

 
   * tool options bar for the rectangular marquee tool 



description of the environment 

!!Toolbox 
!! Typical movable toolbox for all 
available editing/design tools 

!!Panels/Palettes well 
!! A customized are where various 
panels appear 

!! Panels provide viewing and access 
to basic elements of an image or 
the actions upon it 

!!Status bar 
!! Enhanced status bar with a series 
of managerial information 



available menu options 



available menu options 



available panels 



basic panels 
� Depending on the user needs and 
preferences the panels can be arranged 
accordingly 

� Usually, some of the panels that are 
frequently used are being made 
permanently visible 
�  These panels include Navigator, Info, 
Histogram, History and Layers 

� Panel actions can be activated either 
through them, either through the 
corresponding menu options, or through 
keyboard-mouse combinations 

� Menu ‘Window’ controls the visibility 
of the panels 



basic panels 
!! Navigator 

!! This panel displays image canvas navigation 
and zooming capabilities. 

!! A red rectangle indicates the area of the 
image that is currently visible to the user. 
By moving this rectangle one may change the 
visible area of the image 

!! The magnification slider or the percentage 
textbox can be used to change the 
magnification factor by which the image is 
presented (it is not resize!) 

!! Info 
!! This panel presents basic image information 
regarding the position of cursor on the image 
canvas and the corresponding color under the 
cursor 

!! Colors are reported in RGB and CMYK color 
spaces 

!! Coordinates are shown using the user-defined 
units (preferences) 

!! Histogram 
!! This panel presents histograms of the image in 
real time for any of the color channels or the 
intensity channel, along with statistics of 
the selected channel 

!! Additional information are presented on mouse 
positions over the graph 
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basic panels 
!! History 

!! Through the History panel one may navigate 
through the previous actions upon the image 

!! Every new processing action is recorded in this 
panel 

!! By selecting any previous action the user may 
return (undo) to that state of the image 

!! The history is being reset every time the image 
file is closed 

!! Additional snapshot capabilities are also 
available to provide instant view of images 
after certain processing 

!! Actions 
!! The Actions panel provides a functionality 
similar to the functionality of macros in other 
software 

!! Sets of processing actions may be grouped and 
recorded as one “action” with a specific name 
and possible keyboard combination for easy 
access 

!! These processing steps within an action are 
sequentially executed and automatically stopped 
on error occurrence 

!! Photoshop provides a set of “Default Actions” 
but each user can create his/her own sets of 
actions 



basic panels 

� Layers 
�  The Layers panel provides 

�  Access and management on image layers 
�  Access to special layers 
�  Access to layer blending options and effects 

�  Layers can be  
�  visible or hidden 
�  grouped 

�  Different functionalities 
are available through clicks 
on the image thumbnails, the 
layer names and the various 
icons above and below the 
layer list 

Layer	
  blending	
  bar	
  

Group	
  of	
  layers	
  

Indica.on	
  of	
  effect	
  on	
  layer	
  

Simple	
  text	
  layer	
  

List	
  of	
  layer	
  ac.ve	
  effects	
  

Typical	
  image	
  layers	
  

Special	
  gradient	
  map	
  layer	
  

Layer	
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  buCons	
  



basic panels 

� Layers 
�  Demonstration of layer management options 



basic panels 
!! Paths 

!! Photoshop provides vector graphics 
functionalities 

!! The Paths panel is related to 
vector graphics and path selections 

!! Different paths can be kept in 
different path-layers 

!! Channels 
!! The Channels panel presents all the 
image channels  

!! Color channels are presented first 
(i.e. RGB, CMYK) 

!! Three types of channels are defined 
!! Color channels 

!! Typical color channels 
!! Alpha channels 

!! Transparency channel 
!! Spot channels 

!! Products of alpha channels 



the toolbar 

!!The toolbar consists of 
families of tools 
!! Provide manual editing/drawing 
functionalities 

!! One of the most important panel 
of Photoshop 

!!Tooltips are provided for each 
tool 

!!Tools with a small arrow 
(bottom-right) are part of 
tool families 
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Zoom (Z) 
Foreground/Background colors (Default D) 
Quick mask mode (Q) 



the toolbar 
Move tool is used to move objects or selected image areas 

Marquee tools are used to select simple areas of images 

Lasso tools are used to select complex areas of images 

Magic wand and quick selection tool are used to select areas based on the 
color 

Crop tools are used to crop, slice or correct the perspective of images 

Eyedropper tool is used to sample image colors 

Patch tool, like the other tools of the family (healing brush tool and spot 
healing brush tool) can be used to erase artifacts in images. The red eye tool 
also included in the family corrects the red eye problem in photos of persons 

Brush tool helps in painting on an image canvas. Pencil tool is also included 
in this family. Color replacement tool in the same family help replace colors 

Clone stamp tool clones areas of images onto other areas. Pattern stamp tool 
paints using an image area as a pattern 

History brush tool paints a copy of a selected state or snapshot on image. Art 
history brush tool in the same family, uses various brushes to paint states 
and snapshots 

Eraser tools are used to erase image areas 



the toolbar 
Paint bucket tool fills homogeneous areas with the foreground color. Gradient 
tools create color gradients in various forms 

Blur tool blurs image areas using a brush. Sharpen tool sharpens area images 
using a brush. Smudge tool smudges an image 

Dodge tool increases the brightness/contrast of an image area in contrast to 
the Burn tool which decreases the brightness/contrast of an image area. Sponge 
tool affects the saturation of colors in an image area 

Pen tools are used to create vector graphics. Custom shape tool aids in 
inserting predefined vector shapes 

Type tools create vector text in a new image layer  

Path selection tools select shapes or segments 

3D object rotate tool belongs to a family of 3D manipulation tools 

3D rotate camera tool belongs to the family of 3D view manipulation tools 

Hand tool moves an image within the viewing window 

Zoom tool zooms in or out the image viewing window 

Foreground/background colors and selection 

Quick mask mode changes the usual usage of other tools like the brush tool to 
use them as selection tools 



tool options bar 

!!Below the Photoshop menu is the tool 
options bar 

!!Provides options for every tool 
selected from the toolbar 

!!The bar is movable 



workspace customization 

!!Workspace can be customized 
(here an example) 
!! Right click on “Color/Swatches/
Style” and select “Close Tab Group” 
to hide the panels 
!! This can be also done by deselecting the 
corresponding menu options in the menu 
“Window” 

!! Do the same on “Adjustments/Masks” 
panel 

!! From the “Window” menu options, 
activate the “Navigator/Histogram/
Info” and “History/Actions” panels  

!! The panel “Layers/Channels/Paths” 
should be definitely visible 

workspace customization



workspace customization 

!!Workspace can be customized (here an 
example-continued) 
!! Through menu > “Edit” > “Keyboard 
shortcuts” change the key combinations 
regarding the unde/redo actions 
!! “Undo/Redo” should be controlled by “Alt+Ctrl
+Z” 

!! “Step Backward” should be controlled by “Ctrl
+Z” 



workspace customization 

!!Save the customization through menu 
Window > Workspace > New Workspace… 

!!Name the workspace for future 
reference 



practice, practice, practice 
Typical workflows using real examples 



basic color 
retouching 

� Layer 
duplication 

� Adjustment 
layers 

� Blending 
options 

http://goo.gl/y9RwMX lang:GR 



coloring 

� Selecting 
� Adjusting Hue/Saturation 

� Duplicating layers 
� Setting blending options 

� Using adjustment layers 

http://goo.gl/HeTuOX lang:GR 



text, brush, blending 

� Text editing & advanced text features 
� Brushes and special brush editing 
� Layer blending 
� Using the gradient tool 

http://goo.gl/b1Pb42 lang:GR 



composition 

� Layers 
� Text 
� Blending 
� All together 

http://goo.gl/lnCo1b lang:GR 



healing & liquifying 

!!Healing brushes 
!!Manual liquifying filter 

http://goo.gl/58Ro4j lang:GR 



making art 

� Multiple images 
� Multiple layers 
� Multiple blending 
effects 

� Multiple masks 
� Multiple filters 
� Multiple image 
processing 
actions 

http://goo.gl/frBRhF lang:GR 



grid design & templates 

http://www.ravelrumba.com/photoshop-grids/ 



the golden ratio in design.- 



Fibonacci (Leonardo Pisano/da Pisa).- 
“Liber Abaci” (Book of Calculation), 1202 

!!How many pairs of rabbits would have 
been bred in a year, starting with 
one pair? 
!! every month a pair produces another pair 
!! reproduction starts on the second month 



Fibonacci (Leonardo Pisano/da Pisa).- 
“Liber Abaci” (Book of Calculation), 1202 

!! 1st month: 1 pair 
!! 2nd month: 1 pair 
!! 3rd month: 2 pairs 
!! 4th month: 3 pairs 
!! 5th month: 5 pairs 
!! 6th month: 8 pairs 
!! 7th month: 13 pairs 
!! 8th month: 21 pairs 
!! 9th month: 34 pairs 
!! 10th month: 55 pairs 
!! 11th month: 89 pairs 
!! 12th month: 144 pairs 

f(n) = f(n-1) + f(n-2) 



Fibonacci’s sequence.- 

0 

1 

1 

2 

3 

5 

8 

13 

21 

34 

55 

89 

144 

233 

377 

610 

987 

1.597 

2.584 

4.181 

6.765 

10.946 

17.711 

28.657 

46.368 

75.025 

121.393 

196.418 

317.811 

514.229 

832.040 

1.346.269 

2.178.309 

3.524.578 

5.702.887 

9.227.465 

14.930.352 

24.157.817 

39.088.169 

63.245.986 

102.334.155 

165.580.141 

267.914.296 

433.494.437 

701.408.733 

1.134.903.170 

1.836.311.903 

2.971.215.073 

4.807.526.976 

7.778.742.049 

102.334.155 

165.580.141 

7.778.742.049 

million 



the ratio in Fibonacci’s sequence.- 
1 1 2 3 5 8 13 21 34 55 89 144 233 377 610 
1/1 = 1.0000000000000000000000000000000000000000… 
2/1 = 2.0000000000000000000000000000000000000000… 
3/2 = 1.5000000000000000000000000000000000000000… 
5/3 = 1.6666666666666667406815349750104360282421… 
8/5 = 1.6000000000000000888178419700125232338905… 
13/8 = 1.6250000000000000000000000000000000000000… 
21/13 = 1.6153846153846154187760930653894320130348… 
34/21 = 1.6190476190476190687661528500029817223549… 
55/34 = 1.6176470588235294378876005794154480099678… 
89/55 = 1.6181818181818181656694832781795412302017… 
144/89 = 1.6179775280898875955415405769599601626396… 
233/144 = 1.6180555555555555802271783250034786760807… 
377/233 = 1.6180257510729614267575016128830611705780… 
610/377 = 1.6180371352785145599995075826882384717464… 

0000000000000000000000000000000000000… 
0000000000000000000000000000000000000… 
0000000000000000000000000000000000000… 
6666666666667406815349750104360282421… 
0000000000000888178419700125232338905… 
0000000000000000000000000000000000000… 
3846153846154187760930653894320130348… 
0476190476190687661528500029817223549… 
6470588235294378876005794154480099678… 
1818181818181656694832781795412302017… 
9775280898875955415405769599601626396… 
0555555555555802271783250034786760807… 
0257510729614267575016128830611705780… 



the ratio in Fibonacci’s sequence.- 

�  It can be proven that the ratio 
corresponds to the irrational number: 

�  Ancient Greeks 
�  named this number the golden section 
�  used the φ letter as a symbol to this 
number  

�  regarded the ratio φ:1 the perfect ratio 
aesthetically (golden ratio) 

�  used the golden ratio in arts and 
architecture - in design in overall 

2
51+
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the number ! in our world.- 
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the number ! in our world.- 
!! And it is not only in shapes… 
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the number ! in our world.- the number the number the number the number ! in our worldthe number ! in our worldin our world.- in our world.- in our worldin our world





known ‘unknowns’.- 

Unique properties: 
!   = 1,618033989… 
!2  = !+1 = 2,618033989… 
1/!  = !-1 = 0,618033989… 

Euler number 
e=2.718281828… 

hypotenuse of a square "2=1.414213562… 

circumference/diameter 
#=3.141592653… 

…by the way…always remember  
Euler’s identity: ej#+1=0 
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the arts.- 
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the arts.- the arts



poetry.- 

Counting syllables… 
(the number of syllables in each verse follows the Fibonacci sequence) 
 
1  I 
1  am 
2  sitting 
3  quietly, 
5  listening for the 
8  quiet noises in the darkness, 
13  ghostly images flying between the tall pine trees, 
21  illusion created by the mind, made by shadows, the brain playing tricks on 
itself. 
34  It sits there, the raven, black as night, looking at me with its dark eyes 
in the dark night. Inspiration comes. Words form in my head. Evermore. 
 
-Jim T. Henriksen 



music.- 
The golden string (Fibonacci word, rabbit sequence) 
1 0 1 1 0 1 0 1 1 0 1 1 0 1 0 1 1 0 1 0 1 1 0 1 1 0 1 0 1 1 0 1 ... 
 
s(0)=0                          = 0 
s(1)=1                          = 1 
s(2)=1+0                        = 1 
s(3)=1+0+1                      = 2 
s(4)=1+0+1+1+0                  = 3 
s(5)=1+0+1+1+0+1+0+1            = 5 
s(6)=1+0+1+1+0+1+0+1+1+0+1+1+0  = 8 
 
 
Music 
 '1' represent D note (D, 1173.33Hz) 
 '0' represents next octave D (D, 2346.66 Hz) 
The sound of the golden string: 
Composition using the Fibonacci sequence:            (1961 John Chowing, Daisy Bell) 

Composition using the Fibonacci sequence:            (1977 John Chowing, Stria) 

Music based only on the Fibonacci sequence:                  (1988 Al Biles, PGA-1) 

 

Composition using the Fibonacci sequence:            Composition using the Fibonacci sequence:            
                

           



cinema.- 

1925, Sergei Eisenstein, The Battleship Potemkin 
 the length of the film from scene to scene 
 follows the golden ratio 



beauty(?).- 

� Definition(?) 
�  The quality or a combination of 
qualitative elements of an object or 
subject that trigger a combination of 
strong positive feelings and a high 
degree of attraction to an observer 

�  Special case on human face 
�  ‘Qualities’ into four categories 

�  Colour, Texture, Size, Shape 

 

(*) Marquardt Beauty Analysis [http://www.beautyanalysis.com/index2_mba.htm] 



beauty(?).- 

Formation of a ‘beauty mask’ 



beauty(?).- 

Formation of a face from the model mask 



beauty(?).- beauty



beauty(?).- 

!!Ultimately, one mask for each sex 



beauty(?) – test.- 



beauty(?) – test.- 



beauty(?) – symmetry.- 



design.- 
golden ratio 

rule of third 

p
o
i
n
t
s
 
o
f
 
i
n
t
e
r
e
s
t
 



visual design - examples.- visual design - examples.- visual design - examples.- visual design - examplesvisual design - examplesvisual design - examplesvisual design - examplesvisual design - examples


